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REGULATION INFORMATION  

The StenoCast RED must be installed and used in strict accordance with the 
manufacturer’s instructions.  This device complies with the following radio frequency 
and safety standards. 
This device complies with Part 15 of the FCC Rules.  Operation is subject to the 
following two conditions: 
(1) This device may not cause harmful interference. 
(2) This device must accept any interference received, including interference that may 

cause undesired operation.  

Federal Communication Commission Interference Statement 
This equipment has been tested and found to comply with the limits for a Class B digi-
tal device, pursuant to part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures: 

Reorient or relocate the antenna. 
Increase the separation between the equipment and the receiver. 
Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 
Consult the dealer or an experienced radio/TV technician for help.  

Installation and use of this Wireless LAN device must be in strict accordance with the 
instructions included in the user documentation provided with the product. Any 
changes or modifications (including the antennas) made to this device that are not ex-
pressly approved by the manufacturer may void the user’s authority to operate the 
equipment. The manufacturer is not responsible for any radio or television interfer-
ence caused by unauthorized modification of this device, or the substitution of the 
connecting cables and equipment other than manufacturer specified. It is the responsi-
bility of the user to correct any interference caused by such unauthorized modification, 
substitution or attachment. 
Manufacturer and its authorized resellers or distributors will assume no liability for any 
damage or violation of government regulations arising from failing to comply with 
these guidelines. 
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Thank you  
Thank you for purchasing the StenoCast RED Wireless Realtime System 

featuring Bluetooth wireless technology.  The StenoCast RED creates a wireless          
connection between the Court Reporter’s laptop and up to seven attorney/client lap-
tops.    

FEATURES  

Support for Microsoft Windows 98, Windows 2000, XP Home, Windows XP Pro, 
Vista 
Easy operation and setup 
Sends a Wireless Realtime Signal to up to seven clients  

SYSTEM REQUIREMENTS  

One available built-in Serial Port or one available USB port.     
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StenoCast RED Quick Setup 

                                        Step 1: 
Check the contents of your StenoCast RED System.  There 
should be: 

1 StenoCast RED Unit 
1 USB cable 
1 StenoCast Utilities CD 
1 StenoCast RED Instruction Manual and Quick Setup guide 
1 AC power supply  (not needed if you plug in via USB)  

                                                   Step 2:   

Insert the StenoCast CD into your computer.  The CD will start automatically 
and install the driver.    

Vista Users:  You will be prompted to allow the program “dpinst.exe” to 
continue.   Click “Continue” and the driver will be installed.  

Once the driver is loaded (your computer’s CD drive will start spinning  and then it 
will stop, usually in less than one minute),  you can then connect the StenoCast 
RED to your computer via the USB cable (provided).    

Your StenoCast RED is now properly connected to your computer.  Please 
proceed to the next section for instruction on determining the COM port     
number assigned to your StenoCast RED.  

RED Operational Instructions are located on page 16.    
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Step 1:  

Turn on your laptop or computer if 
you have not already done so.  Now 
we will check the COM port number 
of your StenoCast RED.  From your 
Windows desktop click   

START>CONTROL PANEL   

Step 3:  

                (Windows XP) 
Next, double-click the SYSTEM Icon.  
Then click the HARDWARE tab.  
Now click the DEVICE  MANAGER 
button.   

Step 2:  

Check to make sure you are in     
Classic View.  If you are not, switch to 
Classic View.    

              (Windows XP)   
At the Control Panel window       
double-click the SYSTEM Icon.    

             (Windows Vista) 
At the Control Panel window       
double-click the Hardware tab. 

Checking Com Port Settings 
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Step 4:  

Once the Device Manager window is    
visible,  you should see a section labeled 
PORTS.  Click on the + sign to expand 
the tree.  Locate what COM ports the 
StenoCast RED has been assigned to.    

The lower of the two COM ports is set 
for Caseview (2400 baud) and the higher 
COM port is set for the Lawbridge format 
(38400 baud).   

Once you know the COM port numbers 
the RED is assigned to, you are then ready 
for the final part of the Reporter        
computer setup.   
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CaseCat Configuration 
Step 1:   

From the Default 
screen click the  
Translate button or 
type Ctrl+T to enter 
the translate window.  
In this window make 
sure the Output To 
pull-down menu is set 
to CaseView and the 
Remember Setting 
box is Checked.  Next, 
click the Options tab 
in the lower left corner 
of the translate        
window.   

Step 2:  

Then Click  the Output to 
CaseView tab.  In this    
window make sure your 
COM Port number 
matches the LOWER of 
the two COM port    
numbers assigned to your     
StenoCast RED.   Also,  
make sure that the Output 
over comm port box is 
checked and the Direct 
(Cable) bubble is selected.   

Your CaseCatalyst software 
is now configured to use the 
StenoCast RED.  To set up 
an attorney or client      
computer to receive realtime 
from the StenoCast RED, 
please see the RED Client 
Manual. 
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Total Eclipse Configuration 

Step 1:  

From the default screen click 
the Settings button in the 
upper left area of the screen.   

Step 2:  

Click the Realtime tab near the 
top of the window.  You should see 
the current output format in this     
window.  Now click the Add or 
Change button under Output 
formats.  This will open the    
Output format window. 
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Step 3:   

Now use the pull-down menu next to Output and select  Summation/
CaseView.  Next, click the Setup button.  This will open the COM Port Setup 
window (Pictured below).  Make sure the lower of the two RED COM Port   
numbers listed in Device Manager is entered here and the baud rate is set at 
2400.    

Then, you will repeat the above process, and in the Output format menu select 
Bridge.  Click the Setup button.  Make sure the higher of the two RED COM 
Port numbers is entered here and the baud rate is set at 38,400. 

When you have completed the    
StenoCast RED configuration, your 
Total Eclipse Output formats      
window will look similar to the one 
pictured here. 
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DigitalCAT Configuration 
Step 1:  

From the default screen of DigiCat , 
Click the Options tab and select 
CIC from the menu.  This will open 
the CIC Setup window. 

Step 2:  

Once in the CIC Setup window, make 
sure that the lower of the two COM 
port  numbers listed in Device 
Manager for the StenoCast RED is 
entered here and that the baud rate 
is set at 2400.  That’s it for the setup.  
The next step will show how to initi-
ate realtime transmission in DigiCAT. 

Step 3:  

In order to send out Realtime in  
DigiCat, Realtime must be initialized.  
When  starting Realtime, select the 
Tools menu from the default screen.  
Then find CIC on the pull-down 
menu and select Start Session.  
DigiCat will now send out   Realtime.    

To set up an attorney or client  com-
puter to receive realtime from the 
StenoCast RED, please see the RED 
Client Manual. 
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StenoCAT Configuration 

Step 1:  

From the default screen open 
the Tools menu at the top of 
the window.  Then select User 
Preferences from the menu. 

Step 2:  

You should now see the User    
Preferences window.  First, click on 
the Realtime tab near the top of the 
window.  Make sure the bubble next 
to Serial Connection is selected.    

Make sure that the lower of the two 
COM port  numbers listed in    
Device Manager for the StenoCast 
RED is entered in the Port drop-
down menu.  

Set the Baud rate to 2400.    

Next, check the Setting pull-down 
menu.  It should show 8-N-1.    

Then make sure the Output Type is 
set to CaseView.  Next click OK to 
save the  settings.    

Your Realtime output settings are 
now   configured for your StenoCast 
RED. Proceed to the next page for 
connection  instructions.   
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Step 3:  

From the default screen open the File 
menu.  Then select Start Realtime.   

Step 4:  

From the Realtime window select 
Start new job (or append to existing 
job if you wish).  Then click OK. 

Step 5:  

Choose a name for the new job (or 
select an existing file if appending an 
existing job).  Then click OK.  That’s it.  
You are now sending out realtime 
wirelessly with your StenoCast RED.   
To set up an attorney or client com-
puter to receive realtime from the 
StenoCast RED, please refer to the 
RED Client Manual. 
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SmartCAT Configuration 

Step 1:  

From the default screen open 
the Setup menu at the top of 
the window.  Then select  
Realtime Options from the 
menu. 

Step 2:  

You should now see the Real-
time Options window.  Select 
Caseview as your Output For-
mat.  Then click the Setup  
button next to the Output For-
mat. 

Step 3:  

Once in the Caseview Output        
Settings window, make sure that 
the lower of the two COM port  
numbers listed in Device Man-
ager for the StenoCast RED is  
entered in the Port drop-down 
menu.  

Proceed to the next page for in-
structions on how to send out  
realtime with SmartCAT. 
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Step 4:  

To start realtime in SmartCAT, 
open the File menu near the top of 
the window.  Then select New Job 
from the menu. 

Step 5:  

You will now see the New Job  
window.  Enter all appropriate        
information and then click OK. 

Step 6:  

Next, open the Realtime menu near 
the top of the window.  Then select 
Start Realtime.    

You are now  sending out Realtime 
wirelessly with your StenoCast RED.    

To set up an attorney or client    
computer to receive realtime from 
the StenoCast RED, please see the 
RED Client Manual. 
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Getting familiar with your 
StenoCast RED 
(Refresh-Enabled Device)  

Almost all reporters will connect to their RED via their USB port.  You may 
plug the RED directly into the computer’s USB port or use a USB hub.  

Before your first use, insert the StenoCast CD into your CD drive.   The CD 
starts automatically and loads quickly.  Once your RED driver is installed, go o 
to Device Manager and look at Ports to determine what COM ports the RED 
was assigned to.  They will be entitled, “StenoCast RED” followed by the COM 
port number.  Jot those COM port numbers down and then enter those num-
ber in your CAT software’s outgoing   realtime settings.  

Note:  You will see two StenoCast RED devices listed under Ports.  The first 
listed RED device (with the lower COM port number) is the device that    
transmits to Clients using the CaseView protocol at the 2400 baud rate, and the 
second listed RED device (with the higher COM port     number) is the device 
that transmits to Clients using the Bridge protocol at the 38,400 baud rate.    

Your RED kit comes with an optional AC power adapter.  If you choose to plug 
your RED into a USB hub along with other devices, it may be necessary to then 
use the AC power adapter to power the RED device.  If you plug the RED   
directly into to your computer’s USB port, no outside AC power source is  
necessary.  

Operation Instructions  

1) Plug the USB cable into the RED and the other end into your computer. 
2) Have the Judge/Attorneys plug in their USB Ez Receivers (Red or Blue) and 

open up a realtime file in their litigation-support software. 
3) The RED will automatically go into Test Mode.  The RED will transmit the 

message “Wireless Connection Successful” every ten seconds.  This will 
allow the parties to test the realtime signal without the reporter hitting 
keys on their steno machine.  Test mode will stop once the reporter hits 
their first steno stroke.  To re-initiate Test Mode, unplug the USB cable 
attached to the RED and then plug it back in.  That will restart the RED and 
re-initiate Test Mode. 
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LCD Screen Messages  

StenoCast RED 
Status Ready  

Your RED is plugged into either the USB port or the USB hub, and 
the RED unit is powered on.  No wireless connection has been    
established with any Ez Receivers.    

StenoCast RED 
Clients Online  

One or more Ez Receivers have connected with the RED.  Realtime 
is ready to be initiated.  If no steno strokes have been hit, Test 
Mode will be initiated.    

Clients Online 
Realtime Online  

The wireless connection is established and realtime is being      
transmitted by the RED and received by one or more Ez Receivers.     
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How to Change an Assigned 
COM Port Number 

Go to Device Manager / Ports 

Double click on the port you would like to assign 
a different COM port number to. 

Select the Port Settings tab, and then 
click Advanced 
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At the bottom of this window you will see COM 
Port Number and a drop-down menu with a COM 
port listed.   Select a COM number (lower numbers 
are better) and then click OK.  You may then     
receive a warning message.  Click Yes that you 
would like to continue. 
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How to View Device Manager 
when you are “Locked Out” 

Click on the Start button, and then click 
Help and Support. 

In the upper left corner you should see a 
Search box.  Type in “Device Manager” and 
click the arrow. 

When the search results are displayed, in the 
left column under the heading Overviews, Arti-
cles and Tutorials, at the bottom you will see 
“Device Manager.”  Click on “Device Manager.” 

When the results are displayed in the main 
pane, you can then click on “Open Device Man-
ager.” 
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Power Mangement;  USB  

Turn off USB power saving mode 

 

Go to Device Manager.  Scroll down to Universal Serial Bus        
controllers.  Click on the plus (+) sign.  Starting at the bottom,    
double click on USB Root Hub. 
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Make sure there is not a check mark in the box next to “Allow 
the computer to turn off this device to save power.”  After you 
click “OK,” then proceed to the next “USB Root Hub” and double 
click that item and repeat these same steps. 
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Power Management:  Laptop  

Turn off power saving features 

In Control Panel double click the Power Options icon. 
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Make sure the Power schemes is set to “Always 
On,” and the Settings for Always On power 
schemes are all set to “Never.” 
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